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1 What's New

New features in ODBC Driver for Trello 1.0

e |nitial release of ODBC Driver for Trello
e Windows 32-bit is supported
e Windows 64-bit is supported

2 General Information

1. Overview
2. Features

3. Compatibility

4. Requirements

5. Licensing
6. Getting Support

21 Overview

Overview

Devart ODBC Diriver for Trello is a high-performance connectivity solution with enterprise-
level features for accessing Trello from ODBC-compliant reporting, analytics, Bl, and ETL
tools on both 32-bit and 64-bit Windows. Our ODBC driver fully supports standard ODBC API
functions and data types and enables easy and secure access to live Trello data from

anywhere.
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/ ODBC API M
+ ODBC Data Types T
T T

Connection to Trello

Our data connector enables various ODBC-aware applications to connect to Trello directly
via HTTPS. If you have no direct access to Trello via HTTPS, you have the option of

establishing a connection through a proxy server.

Application
HTTPS
ODBC Interface
Driver Manager Proxy
Trello
Devart ODBC Driver Cloud

far Trello

2.2 Features

Connection to Trello

Application

HTTPS
ODBC Interface m

Driver M, Prox: .. . .

o anager ’ Trello Our connectivity solution enables various
Devart ODBC Driver Cloud

forele ODBC-aware applications to connect to

Trello directly via HTTPS. If you have no
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direct access to Trello, you have the option
of establishing a connection through a

proxy server.

Extended SQL Syntax

Our ODBC driver provides an unrivalled
opportunity to work with Trello objects just
as with SQL tables. The extended SQL

syntax allows you to use all the SQL

Select A Name,

benefits in SQL-92 compatible SELECT L seanares
From Agents A
. ih RoleID In (Select Id
statements: e R I profiles

Where (Permissions_Contacts_View =
Or Permissions_Tickets_View =

® Complex JOINs | And Type = "Administrator’
« WHERE conditions T

® Subqueries

®* GROUP statements

* Aggregation functions

* ORDER statements

® and more.

o—@:ﬂﬂ
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DML Operations Bulk Updates

Devart ODBC Driver for Trello provides Moreover, with our driver you can perform
support for DML (INSERT, UPDATE, bulk updates to Trello by combining SQL
DELETE) operations, which allows youto |statements into batches, thus simplifying
modify data in Trello in the same way as in |and speeding up large data modification
SQL databases. with Trello.

ODBC Conformance

The driver provides full support for common
ODBC interface:

¢ ODBC APIFunctions support % € \

= o
U

* ODBC Data Types support

In addition, we provide support for
Advanced Connection String parameters.
Thus allowing any desktop and web
applications to connect to Trello from
various environments and platforms, that
support ODBC.

Trello Compatibility

+ Trello API m
v Trello Data Types Our ODBC driver fully supports all data
types defined in the Trello API.

Moreover, the driver is compatible with the
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Trello APl itself.

Integration
Advanced Data Conversion

The driver is compatible with 3rd-party data

We have implemented advanced Data analysis tools, such as Microsoft Excel, and
Conversion mechanisms that provide bi-  |integrates with various IDEs and systems
directional mapping between any Trello like Visual Studio, etc.

and ODBC data types. For a complete list of compatible tools and

platforms, see Compatibility.

Platforms Variety Fully Unicode Driver

. With our fully Unicode driver, you can
Devart ODBC Driver for Trello can be used

. ) ) o retrieve and work with any data from muilti-
with 32-bit and 64-bit applications on both
lingual Trello databases correctly, not

x32 and x64 platforms, so there is no need
. . depending on whether its charset is Latin,
to additionally configure the driver,
o ] Cyrillic, Hebrew, Chinese, etc., in any
applications or environment.
environment localization.

High Performance Support

Every operation with Trello becomes o ]

Visit our Support page to get instant help
significantly faster using such capabilities .

from knowledgeable and experienced
of our driver as Local data caching, _ _ _

professionals, a quick resolution of your
connection pooling, query optimization and . . .

problems, and nightly builds with hotfixes.
much more.
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2.3 Compatibility

Trello Compatibility
Trello API v
Trello Data Types d

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)

e Compatible with all Windows versions (Windows Vista and higher) that support .NET

Framework 4.5.

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion

Embarcadero Delphi & C++Builder
FileMaker

Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio

Omnis Studio

PHP

PowerBASIC

CIC SIS SIS LIS SIS

Python
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General Information

Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

CICOIC SO K

SQL Server Reporting Services

Bl & Analytics Software

Alteryx

DBxtra

Dundas Bl

FICO Xpress Mosel

IBM SPSS Statistics

MicroStrategy

Oracle Bl

Power Bl

Qlik Sense

CICIC SIS 1K S

QlikView
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8 ODBC Driver for Trello

RStudio

SAP Crystal Reports
SAS JMP

Tableau

TARGIT

A N N N SN

TIBCO Spotffire

Office Software Suites

LibreOffice
Microsoft Access
Microsoft Excel

OpenOffice

AR N SRR NN

StarOffice

24 Requirements

The following requirements must be met for ODBC Driver for Trello:

¢ Only one version of ODBC Driver for Trello is installed on your system.

e NET Framework 4.5 or later is installed on your system.

2.5 Licensing

ODBC Driver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
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TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
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the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.
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2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

12

ODBC Driver for Trello

2.6

accompanying written materials must be destroyed.
7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.

Getting Support

This document lists several ways you can find help with using ODBC Driver for Trello
describes the Priority Support program.

Support Options
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There are a number of resources for finding help on installing and using ODBC Driver for
Trello:

¢ You can find out more about ODBC Driver for Trello installation or licensing by consulting

Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

® You can get advanced technical assistance by ODBC Driver for Trello developers through

the ODBC Driver for Trello Priority Support program.

Subscriptions

The ODBC Driver for Trello Subscription program is an annual maintenance and support

service for ODBC Driver for Trello users.

Users with a valid ODBC Driver for Trello Subscription get the following benefits:
¢ Product support through the ODBC Driver for Trello Priority Support program
e Access to new versions of ODBC Driver for Trello when they are released

¢ Access to all ODBC Driver for Trello updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Driver for Trello Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for Trello-related questions from the ODBC
Driver for Trello developers themselves. Priority Support is carried out over email and has a
two business day response policy. Priority Support is available for users with an active ODBC
Driver for Trello Subscription.

To get help through the ODBC Driver for Trello Priority Support program, please send an
email to support@devart.com describing the problem you are having. Make sure to include

the following information in your message:

Your ODBC Driver for Trello Registration number.

e Full ODBC Driver for Trello edition name and version number. You can find the version

number in DLL version information.
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14 ODBC Driver for Trello

¢ Versions of the Trello server and client you are using.
e A detailed problem description.

¢ If possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Trello.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com

3 Using ODBC Driver

1. Installation

2. Connecting to Trello

3. Connection String Parameters
4. Enabling ODBC Tracing
5. Supported ODBC API Functions

3.1 Installation

ODBC Driver for Trello currently supports Windows 32-bit and 64-bit.

e Regular Installation

¢ Silent Installation

3.1.1 Windows

Installation on Windows

1. Download and run installer executive file.

2. Follow the instructions in the wizard.
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i3 setup - Devart ODBC Driver for Trello - X

Welcome to the Devart ODBC Driver for
Trello Setup Wizard

This will install Devart ODBC Driver for Trello 1.0.0 on your
computer.

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.,

WARMNING: This program is protected by copyright law and
international treaties.

ODBC Driver
for Trello

Cancel

3. In case you already have the specified installation folder on the PC or another Driver
version is installed, you will get a warning. Click Yes to overwrite the old files with the
current installation, but it is recommended to completely uninstall the previous driver
version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the
driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.
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16 ODBC Driver for Trello

ﬁ! Setup - Devart ODEC Driver for Trello — >
Select Components
Which components should be installed? devart

Select the components you want to install; dear the companents you do not want to
install, Clidk Mext when you are ready to continue,

Full installation w
B Cevart ODBC Driver for Trello 44,2 MB
H Driver for Win32 15,5 MB
‘.. (8 Driver for Winc4 28,7 MB
B Help and Manual 2,4MB

Current selection requires at least 48,8 MB of disk space.

5. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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i¥ setup - Devart ODBC Driver - >
License Information
Fleaze enter the path to the file containing the activation key received when devart

purchasing the product. If you have no activation key, select Trial Version.

() Trial

(®) Activation Key

u 1w FjNODSNGAPOSgfzjuy AEoDpy fgL¥mIX heuy Ho S8N4FZgxWhIiBjXwr LS

Z 1QVwWOUQOOYTqtef2NfkuL gB +FAVeYghal 3cnNhifdvYIrWwFFwZNyIRh2m4s)
7zEIxR 30Fj9BLspR &ydbomxYLUYmTAZAHMQVXWPQON2UM 1Y 40df3c 3T IR AUAG 2d
eminjcTIIN4HEPxigTQRRZBHKT 1L 3IAf01/QfXsIp PikkinDSIbx VK +avKETUP

50w KL FhTw0dv5t5haAtwPzLBaT) 39CIY 3 +2MLSIL3 =|

Load Activation Key ...

7. If you have the activation key file, click the Load Activation Key button and browse to it.

Activation — O 4

= v A « Do, * Activation v O Search Activat...

[ This pc *  Name Date modified Type

_J 3D Ohbyj E activation 27.03.2020 1352 KEY File
B Deskto;
|j Docum

< Downlo

D Music ¥ € >

1 item =
8. Click Next.
9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.
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3.1.2

3.2

3.21

Silent Windows

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCTrello.exe /SILENT /ActivationKey=ylc7nmgdu2341aszxcvONGurjfhxm9o0L
DevartODBCTrello.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRtrilwg
Note: The installation is performed by entering a license key.

DevartODBCTrello.exe /SILENT /ActivationFile=d:\lic.key

DevartODBCTrello.exe /VERYSILENT /ActivationFile=d:\1ic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

Remote Installation

One of the key advantages of Group Policy is the ability to deploy software remotely using MSI
files. This section explains how to use Group Policy to remotely install the ODBC Driver for
Trello on client computers.

The information is organized into the following sections:
e Creating the MST File Using Orca

e Remote Deployment and Activation

e Upgrading Driver Version and License Key

Package Transformation

Creating the MST File Using Orca
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To customize the installation of the ODBC Driver for Trello, you first need to edit the Windows
Installer Package (MSI) by creating an MST file. This will allow for customized installation of
an original Windows Installer (MSI) Package.

An MST file, or Windows Installer Setup Transform file, contains program configuration
settings. In our case, the MST file for the ODBC Driver for Trello will include the correct
license information. This MST file is used together with the original MSI package in the Group
Policy software distribution system.

There are many tools available for customizing MSi file settings, so you can choose the one
that best suits your needs. In this example, we'll be using Orca, which is available as part of
the Windows SDK Components for Windows Installer Developers. For more information
about Orca, visit the official Microsoft website

To start the process of MST file generation using the Orca editor, follow the steps below:

1. Launch the Orca application, then open the required MSl file by selecting Open in the File

menu or click the Open icon on the toolbar below.

€% Untitled - Orca — O X
File Edit Tables Transform Tools View Help
0O = e
Tables
&% Open X
Lookln:|, soft v| (I sl
~
I MName Date modified Type Size
ﬁlDevar‘tODBCSale;force 8/16/2024 410 PM  Windows Installer Package 80,5¢
Quick access
Desktop
m
Libraries
This PC
< >
i File name: | DevartODBC Salesforce ~ | | Open
Network
Files of type: Installer Database Files (*msi, “msm, *pcp, “msp) ~ Cancel
[ Open as read-only
Tables: 0 Mo table is selected. Mo column is selected.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
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Policy installation process. Use the same steps described in this section when installing the
ODBC Driver for Trello.

2. As aresult, the Tables menu on the left side of the main application window will display the

properties of the selected MSl file.

3. Next, navigate Transform -> New Transform.

% DevartODBCSalesforce.msi - Orca

File Edit Tables
O =

Tables
AdminExecuteSeq
AdminUlSequence
AdvtExecuteSeque
AppSearch
Binary
CheckBox
Compeonent
Condition
Control
ControlCondition
ControlEvent
CreateFolder
CustomAction

Transform  Tools

Mew Transform
Apply Transform...
View Patch...
Generate Transform...

Close Transform...

Transform Properties...

View Help

4. To proceed, select Property from the Tables menu, then double-click any empty row on

the right side of the application window.

[+

File Edit Tables Transform Tools View Help

0 & £ f

Tables Property Value
AdminExecuteSequence UpqradeCode

AdminUlSequence
AdvtExecuteSequence
AppSearch

Binary

CheckBox
Component
Condition

Control
CantrolCondition
ControlEvent
CreateFolder
CustomAction
Dialog

Directory
EventMapping
Feature
FeatureComponents
File

lcon
InstallExecuteSequence
InstallUlSequence
LaunchCondition
ListBox

Media
MsiFileHash
Property
RadicButton
ReglLocator
Registry
RemoveFile
Sherteut

Signature
TextStyle

UlText

Upgrade
_Validation

WixUIRMOption
WIXULINSTALLDIR
I5Trial

ALLUSERS
Producthame
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT
WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPNOMODIFY

Manufacturer
ProductCode
Productlanguage
ProductVersion
DefaultUIFent
WixUl_Mode
ErrorDizlog
Infolcon

CRLF

TAB

SPACE
AdminProperties
SecureCustomProperties

WIXUI_CUSTOMEXITDIALOGOPTIONALCHECKBOX

UseRM

INSTALLLOCATION

Trial

2
Devart ODBC Driver for Salesforce

App.ico

{BE17AZF6-2B64-4ADF-A3EB-82DF 16208457}
1

https://forums.devart.com/viewforum.phpif=35

MSIUSEREALADMINDETECT|

httne: devart.
Add Row x
Name  Value
(E’ Property ACTIVATIONKEY
Value
Column
Value - Localizable String[0], Required
QViwaea/GiSk OBV v SARFMSD/LmuPAISSTRCAFAS|

C Driver for Salesforce 3.4.1 on your computer. Click Mext to continue or Cancel to exit.

K3z}

TEXT
WERFOUND; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED
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In the Add Row dialog that opens, make the following settings and press OK to apply the

changes:

¢ Property - enter ACTIVATIONKEY with capital letters only.

¢ Value - enter the valid OEM license key for the ODBC Driver for Trello.

As shown in the following screen, a new property, ACTIVATIONKEY, has been added, with

the license key displayed in the value column next to it.

5. Once the configuration changes have been made, select Transform -> Generate

Transform.

&% DevartODBCSalesforce.msi (transformed by Untitled) - Orca
File Edit Tables Transform Tools View Help

0= E New Transform

Tables Apply Transform... Value
AdminExecuteSeq View Patch... {8E17A2FG-2B64-4ADF-AZEB-82DF1620B457}
AdminUlSequence "DIALOGOPTIONALCHECKBOX 1
AdvtExecuteSeque Ezrani i UseRM
AppSearch Close Transform INSTALLLOCATION
Binary Trial
CheckBox Transform Properties... 2
Component | Fiooucovanme Devart ODBC Driver for Salesforce
Condition ARPPRODUCTICON Appico
Control ARPHELPLINK https://forums.devart.com/viewforum.php?=53
ContrelCondition ARPURLINFOABOUT https://www.devart.com/odbc/
ContrelEvent WELCOME_TEXT The Setup Wizard will install Devart QDBC Driver for Salesforce 3.4.1 on your computer. Click Next to continue or Cancel to exit.
CreateFolder EXISTS NO
CustemAction ISVALIDLICENSE 0
Dizleg ARPNOMODIFY 1
Directory MSIUSEREALADMINDETECTION 1
EventMapping Manufacturer Devart
Feature ProductCode {AEF4136F-3503-4528-9FD4-8885780CC432}
FeatureComponents ProductLanquage 1033
File ProductVersion 341
lcon DefaultUIFont WixUl_Font_Narmal
InstallExecuteSequence Wixll_Made Mondao
InstallUlSequence ErrarDialog ErrorDlg
LaunchCenditicn Infolcon info
ListBox CRLF
Media TAB
MsiFileHash SPACE
Property AdminProperties WIXUI_CUSTOMEXITDIALOGOPTIONALTEXT
RadioButton SecureCustomProperties ARPNOMODIFY; NETFRAMEWORK45; NEWERFOUND; OLDESTFOUND;SELFFOUND; WIX_UPGRADE _DETECTED
Reglocator ATIONKEY ulw/ICODBNGAEDFabNziuTLDiB5LOdQuENtaNBHxoRz+tC/nd4kREUCEPBZ4xBLAMHK2P2X 54Kt TPLYidECtHftiU/ uV2KDSEhX3LXEGN
Reqistry
RemoveFile
Shortcut
Signature

6. In the Save Transform As dialog that appears, enter a suitable name for the new MST file

and click Save to apply your settings.
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=
File Edit Tables Transform Tools View Help
D& RO LA
Tables Property Value
AdminExecuteSequence UpgradeCode {8E17A2FG-2B64-4ADF-A3EB-22DF1620B457}
AdminUlSequence WIXUI_CUSTOMEXITDIALOGO 2 Save Transform As %
AdvtExecuteSequence ‘WixUIRMOption
AppSearch WIXUI_INSTALLDIR .
Binary I<Trial Savein: | soft v @& e mr
CheckBox ALLUSERS -
Component ProductName % Name Date modified  Type Si
Condition ARPPRODUCTICON Na items match your search.
Contral ARPHELPLINK Quick access
ContrelCondition ARPURLINFOABOUT
ControlEvent WELCOME_TEXT - puter. Click Next to continue or Cancel to exit.
CreateFolder EXISTS
CustemAction ISVALIDLICENSE Desktop
Dizleg ARPNOMODIFY
Directory MSIUSEREALADMINDETECTIO|
EventMapping Manufacturer n
Feature ProductCode Libraries
FeatureComponents PreductlLanquage )
File ProductVersion &
lcon DefaultUIFont =
InstallExecuteSequence Wixll_Mode This PC
InstallUlSequence ErrarDialog
LaunchCondition Infalcon S
ListBox CRLF L < >
Media TAB Network
Hash SPACE Fie name [Dsvat0DECSalestoree v [ e
i AdminProperties
RadioButton SecureCustomProperties Save as type: Windows Installer Transform (" mst) ~ Cancel GRADE_DETECTED
Reglocator (34K TPLYidECtItftil
Registry

RemanveFile

7. If successful, the encryption message DevartODBC Salesforce.msi (transformed by

DevartODBC Salesforce.mst) - Orca will be displayed at the top of the Orca application

window.

ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce.mst) - Orca — [} s
File Edit Tables Transform Tools View Help
b= % B
Tables ~ | Property Value ~
AdminExecuteSequence WixUIRMOption UszeRM
AdminUlSequence WIXULINSTALLDIR INSTALLLOCATION
AdvtExecuteSequence I=Trial Trial
AppSearch ALLUSERS 2
Binary ProductMName Devart ODBC Driver for Salesforce
CheckBox ARPPRODUCTICON App.ico
Component ARPHELPLIMEK https://forums.devart.com/viewforum.phpif=53
Condition ARPURLINFOABOUT https://www.devart.com/odbc/
Control WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.4.1 on you
ControlCondition EXISTS MO
ControlEvent ISVALIDLICENSE 0
CreateFolder ARPMNOMODIFY 1
CustomAction MSIUSEREALADMINDETECTION 1
Dialog Manufacturer Devart
Directory ProductCode {AEF4136F-3503-4528-9FD4-2885780CC432}
EventMapping Productlanguage 1033
Feature ProductVersion 341
FeatureComponents DefaultUIFont WixUl_Font_Mormal
File Wixl_Mode Mondo
lcon ErrorDialog ErrorDlg
InstallExecuteSequence Infolcon info
InstallUlSequence CRLF
LaunchCondition TAE
ListBox SPACE
Media AdminProperties WIXUILCUSTOMEXITDIALOGOPTIOMNALTEXT
MsiFileHash SecureCustormProperties ARPNOMODIFY: NETFRAMEWORKAS;NEWERFOUMND; OLDESTFOUMD; SELFF
Property | ACTIVATIONKEY ulw FabNzi 2Et1C CTlh+ LHrTrc1RLF:
RadicButton ¥
Realocator bl B >
Tables: 37 Property - 29 rows Mo celumn is selected.

In case of a positive outcome, the newly created MST file will be located in the folder you
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specified, alongside the MSl file.

3.2.2 Deployment and Activation

Installing and Activating Software Remotely

Group Policy automated-program installation is specifically designed for deploying Windows
Installer packages (MSl files). Therefore, when deploying the ODBC Driver for Trello using
Group Policy, be sure to use the corresponding MSl file for the ODBC Driver for Trello.

Prerequisites: Locating the MSI Installation File

Prior to making configuration settings in the Group Policy, you'll need to create a distribution
folder:

1. Create a shared network folder on the publishing server.

2. Set the appropriate sharing permissions on this folder to allow read access to the driver

installation package for all domain users.

3. Download the ODBC Driver for Trello MSl file, and place it in the network folder.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the

ODBC Driver for Trello.

Further in this section, you'll find more detailed information on how to deploy and activate the
ODBC Diriver for Trello on remote client computers using Group Policy.

Server-Side Actions
1. Open the Group Policy Management desktop application.

2. In the Group Policy Management window, navigate to the desired forest node, then
expand the appropriate option under the Domains node. For this example, we'll select
devart-test.test. Right-click the Domains node, and from the context menu, select Create

a GPO in this domain, and Link it here.
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ZL Group Policy Management

3 File Action

View Window Help -

L Al NERIEREI 7 o

5L Group Policy Management

v _i\‘ Forest: devart-test.test
v (55 Domains
w 3 devart-test.test
s Default Dol
sz Devart ODE
o Windows L
2| Domain Co
= Group Poli
# WM Filters
Ll Starter GPC
i@ Sites
st8 Group Policy Mod
4 Group Policy Resu

Create a GPO in this domain a

devart-test.test
Status  Linked Group Policy Objects  Group Policy Inheritance  Delegation
Create a GPO in this domain, and Link it here...
Link an Existing GPO...

Block Inheritance

*ve Directory and 5YSVOL replication for this domain as it relates to Group Policy.

Group Policy Modeling Wizard... 3t test is the baseline domain controller for this domain. Change

MNew Organizational Unit

Search in exists for this domain.

Change Domain Controller... w to gather infrastructure status from all of the domain cortrollers in this domain.
Remove

Active Directory Users and Computers...

View >

Mew Window from Here

Refresh
Help

3. You can now create a New Group Policy Object. In the New GPO dialog enter a name for

the new object and click OK. The new GPO will then appear within the Group Policy

Management container.

For example, let's create a GPO named after the ODBC driver name.

Mew GPO >
MName:
|Deuart ODBC Driver for Salesforce|
Source Starter GPO:
{none) e

Cancel

Keep in mind that each ODBC Driver for Trello Windows installation package corresponds to

one Group Policy Object (GPO), which is important for managing future software upgrades.

To install multiple drivers using Group Policy, you need to create a separate GPO for each

driver you want to deploy.
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4. Right-click the new object and select Edit from the context menu.

= Group Policy Management —
5L File Action View Window Help

&= HEIXc HE

5k Group Policy Management Devart ODBC Driver for Salesforce
v _ﬁ Forest: devart-test.test

- i Scope  Details Settings Delegation
v |55 Domains

w 3 devart-test.test Links
,J Default Domain Policy Display links in this location: devarttest test
wi Devart ODBC Driver for Salesforce The followinn sites_domains and Ol ls are linked to this GPO:
5| Windows Update Server Edit... — P o
== : orce inl able Eil
2 | Domain Controllers .
v [ 5 Group Policy Objects R No Yes devarttest test
=[ Default Domain Centrollers Pe N Enakie
=[ Default Domain Policy Save Report...
= Devart ODBC Driver for 5alesfc View .
=] Windows Update Server )
% WM Filters Mew Window from Here oy to the following groups, users, and computers:
a Starter GPOs Delete
i Sites Rename
565 Group Policy Modelin
AE p Y g
4 Group Policy Results Refresh
Help we Properties
WMI Filtering

This GPO is linked to the following WMI fiter:

Open the GPO editor

5. In the left pane of the Group Policy Management Editor, navigate to Computer
Configuration --> Policies --> Software Settings --> Software installation. Your
current deployment package will appear in the right pane. Right-click Software

installation, then select New --> Package.
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1L Group Policy Management -
i FI|E . A8 A Llal
E[ Group Policy Management Editor — O *
|
——— File Action View Help
15 Grou
vAres | aF|EGE HME
A =[ Devart QDBC Driver for Salesforce [TE|| Mame - Version Deploymentst... Source
™ v i Computer Configuration
w || Policies
~ [ Software Settings
Software installation
» [ Windows Settings MNew > Package...
> [ | Administrative Templat - R
> || Preferences 1w
v i, User Configuration Paste
4 e
> 4 » || Policies Refresh
i » [] Preferences "
[ port List...
Properties
Help
< IL
Adds a package.
WMI Filtering

This GPO is linked to the following WMI filter:

6. In the Group Policy Management Editor dialog that opens, select the desired MSI

installation file and click Open.

& Group Policy Management —

s File fmtimm  lfim  Ufiecles Llale

| & Group Policy Management Editor - o X
== N
/1| =
|5 Grou [ Open x
e -ﬁ;_ T « test-ad-del » soft v 0 Search soft el
A
o - ==
Organize « Mew folder B== ~ [ o oft\DevartODBCSa...
[&] Pictures ~ Name Date modified Type
B videos 15! DevartODBCSalesforce 8/19/2024 5:50PM  Windows Installer Pack
‘am Local Disk (C:)
|_ﬂ Metwork
_ﬁ L 4 >
i File name: |De\.rartODBCSaIesf0rce v| Windows Installer packages (*.r
< >

WMI Filtering
This GPO is linked to the following WM fitter:
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7. In the Deploy Software dialog, select Advanced to specify the software deployment

method. The Advanced deployment method allows you to make necessary modifications

to the MSl file, such as creating the MST file in Orca.

Deploy Software et

Select deployment method:

Published

Select this option to configure the Published or Assigned options,
and to apply modffications to a package.

Cancel

8. In the Properties dialog of the installation package that opens, go to the Modifications tab

and select Add. Browse for the corresponding MST file, select it, and click Open to apply

the settings.

|58 Group Policy Management

2 File Action View Window Help

e @ X G| |
=5 Group Policy Management Devart ODBC Driver for Salesforce Properties ? x

v ﬂ Forest: devart-test.test o
. General Deployment Upgrades Categories Modffications  Security
~ |55 Domains

v i devart-test.test Modffications or transforms allow you to customize the package and are

4 Default Domain Policy applied to the package in the order shawn in the following list

- O
iz Devart ODBC Driver for Salesford Modifications:
a5 Windows Update Server Move Up
= | Domain Controllers
= Group Policy Objects Move Down ion_Denlovment st Source
& WMI Filters 1=/ Open *
] Starter GPOs
& Sites P L « test-ad-decl » soft v O Search soft -l
s Group Policy Modeling
2 Group Policy Results Organize »  Mew folder - W @
&=/ Pictures L MName Date modified  Type
Removel [ Videos [ DevartODBCSalesforce.mst  8/16/2024 40...  MST File
s Local Disk (C)
Important! Do not press OK uf
comectly. For more informatiol
then dlick What's this? = Network
v £ >
[ZIENLELLEMD evart ODBC Salesforce. mst| v| Windows Installer transform pa
Cance
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9. If configured correctly, the Group Policy Management Editor window should look as

follows:

'=[ Group Policy Management Editor - O hd
File Action View Help
e HEEC= HE

\=[ Devart ODBC Driver for Salesf & || Name
v (i Computer Configuration
w || Policies

~ [ | Software Settings
Software instal
| Windows Settings
| Administrative Ter

| Preferences

Version Deploymen.. Source

Devart ODBC Driver for Salesforce 3.4 Assigned \\test-ad-dcT\soft\DevartODBCSalesforce.msi

w 4 User Configuration w
< >
Client-Side Actions

For the ODBC Driver for Trello to be successfully installed on remote client machines, all
domain users must restart their computers after logging in for the first time.

In case of successful deployment, the ODBC driver will be installed on the client's computer.
To verify, open the ODBC Data Source Administrator on the client's machine and add the
deployed ODBC driver.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using ODBC Driver

Create Mew Data Source

Select a driver for which you want to set up a data source.

MName Version Col
Devart ODBC Driver for Salesforce REXEXRKE De
S0L Server 10.00.15041.01 M

< Back Cancel

All information on the deployed driver is accessible upon clicking the About tab.

29
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Devart ODBC Driver for Salesforce Configuration >
Gereral Advanced Settings Logging License About

Devart ODBC Driver for Salesforce

OEM License

devart

Version: 3.4.1

Web: www, devart, comfodbe/salesforce

E-mail; support@devart.com e

© 2015-2024 Devart, All right reserved.

ODBC Driver
for Salesforce

Test Connection - Ok Cancel

Similarly, the valid license key will be automatically activated after the successful installation
of the ODBC Driver for Trello.
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Devart ODBC Driver for Salesforce Configuration >

General Advanced Settings  Logging License  About

License Information:

Company:
Devart

User name:
ODBC Account

License number:
3519-2CED-001

OEM License:
permits redistribution for using with "Devart” software only

Subscription for free updates expires on 3/21,/2025

Input Activation Key... Deactivate

Test Connection - Ok Cancel

See Also
e Creating the MST File Using Orca

¢ Activating on Windows - ODBC Driver for Trello

e License Information - ODBC Driver for Trello

3.23 Software Upgrade

Automatic Software Update Using Group Policy

If the ODBC Driver for Trello was initially deployed through Group Policy, it can be easily
updated to a newer version. Follow the steps below to update both the ODBC Driver for Trello
and the license to newer versions on all remote computers in the domain.

1. Download the ODBC Driver for Trello installation MSI file of a newer version and place it in

the shared network folder.
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2. Create a new MST file with a new license key using Orca.

If your license is still valid, there's no need to create a new MST file. Use the current MST file

instead.
ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce_new_key.mst) - Orca — [m] *
Eile Edit Tables Transform Tools View Help
= #
Tables ~ | Property Value
AppSearch UpgradeCode {8E17A2F6-2B64-4ADF- ASEB-82DF 16208457}
Binary WIXUI_CUSTOMEXITDIALOGOPTIOMALCHECKBOX 1
CheckBox WixUIRMOption UseRM
Component WIXUI_INSTALLDIR INSTALLLOCATION
Cendition IsTrial Trial
Control ALLUSERS 2
ControlCondition ProductMame Devart ODBC Driver for Salesforce
ControlEvent ARPPRODUCTICON App.ico
CreateFolder ARPHELPLINK https://forums.devart.com/viewforum.php?f=33
CustomAction ARPURLINFOABOUT https://www.devart.com/odbc/
Dialeg WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.3.0 on your computer, Click Next to continue
Directory EXISTS MO
EventMapping ISVALIDLICEMSE ]
Feature ARPNOMODIFY 1
FeatureComponents MSIUSEREALADMIMDETECTION 1
File Manufacturer Devart
lcon ProductCode {73ABASBS-E56E-4828-BE3B-B6FDABSECS39)
InstallExecuteSequence ProductLanguage 1033
InstallUlSequence ProductVersion 3.5.0
LaunchCondition DefaultUIFont Wixl|_Font_Normal
ListBox WixUl_Mode Mondo
Media ErrorDialog ErrorDig
MsiFileHash Infolcon info
| Property CRLF
RadicButton TAB
Reglocator SPACE
Reqistry AdminProperties WIXUI_CUSTOMEXITDIALOGOPTIOMALTEXT
RemoveFile SecureCustomProperties ARPMOMODIFY:NETFRAMEWORK45;NEWERFOUMD; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED
Shortcut ACTIVATIONKEY wi GAEOFabNziuf R2Et1CBDMCTIh+ TVw el HrTrc1RLFrwmdCSa RMXara3)kDofi2d
Signature
TextStyle
UlText
Upgrade
_Validation v | < >
Tahles: 37 Pronerty - 79 rows. Mo column is selected

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Diriver for Trello.

3. Follow the same workflow as outlined in Step 4 to Step 7 of the ODBC Driver for Trello

Remote Deployment and Activation section.

4. In the Properties dialog that appears after selecting the Advanced deployment method,

go to the Upgrades tab and click Add.
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I . — O X
2) Properties ? X
F
H General Deployment Upgrades Categories Modffications  Security
il
fi Packages that this package will upgrade: Add Upgrade Package 4
1 Choose a package from BCSalesforce...
(®) Cumrent Group Policy Object (GPO)
() A specific GPO:

Browse...

Package to upgrade

Devart ODBC Driver for Salesforce (2)

Add... Remove

Required upgrade for existing packages

Packages in the cument GPO that will upgrade this package:

() Uninstall the existing package, then install the upgrade package
(®) Package can upgrade over the existing package

ok Conce

Make sure to select the following check boxes while adding the package:

e Current Group Policy Object
e Package can upgrade over the existing package

5. Browse for the corresponding GPO object and click OK to apply the settings.
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Browse for a Group Policy Object

Domains/OUs  Sites Al

< |
|_'::>
g
[
1

Look in: |5 devart test test

All Group Paolicy Objects stored in this domain:

Mame

|=[ Defautt Domain Controllers Policy
\=[ Defautt Domain Policy

E Devart ODBC Driver for Salesforce
=] Windows Update Server

6. Now the Upgrades tab of the Properties dialog will list a new package with a newer

version.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modffications  Security

Packages that this package will upgrade:

Upgrade Devart ODBC Driver for Salesforce

Upgrade Devart QDBC Driver for Salesforce (2]

Add... Bemove

Required upgrade for existing packages

Packages in the cumert GPO that will upgrade this package:

Corcs

35

7. Go to the Modifications tab in the same properties dialog, click Add and browse to the

MST file.

We have already created a new MST file with a new license key in Step 2.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modifications  Security

Maodffications or transforms allow you to customize the package and are
applied to the package in the order shown in the following list:

Modffications:

West-ad-de 1soft \DevatQDBC Salesforce_new keym Mave Up

Move Down

oo

Impaortart! Do not press OK until all transforms are added and ordered
comectly. For mare information, right-click on the Modfications list box, and
then click What's this?

Corcs

8. In case of a positive outcome both the old and new versions of the driver package will be

displayed in the Group Policy Management Editor.

= Group Policy Management Editor
File Action View Help

as Hm EQ HE

- Devart ODBC Driver for Salesfor|| Name Version Deploymentst.  Source
v i Computer Configuration Devart ODBC Driver for Salesforce 34 Assigned \\test-ad-dc\soft\DevartODBCSal...
v [ Polides Devart ODBC Driver for Salesforce (2) 35 Assigned \\test-ad-dc1\soft\DevartODBCSal..

v [ Software Settings
Software installat

| Windows Settings
| Administrative Templ

| Preferences

- n".; User Configuration
_ Policies
_ Preferences

Once the GPO configuration on the server is complete, the ODBC Driver for Trello will
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automatically update to the latest version each time a client computer restarts.

Client-Side Actions

To update the ODBC Driver for Trello to a newer version on remote client machines, all
domain users must restart their computers after their first login.

If successful, both the driver and the license key will be automatically updated to the new
version on remote computers. For detailed instructions on how to view the technical details of
the ODBC Driver for Trello after upgrading, refer to Client-Side Actions.

See Also
e Creating the MST File Using Orca

¢ Remote Deployment and Activation - ODBC Driver for Microsoft Access

e Activating on Windows - ODBC Driver for Trello

¢ License Information - ODBC Driver for Trello

3.3 Product Activation

See how to activate Devart ODBC Driver for Trello:

e Obtaining Activation Key

e Activation on Windows

e Where to see the license information

3.3.1  Obtaining Activation Key

To obtain a product activation key, follow these instructions:
1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal

account.

4. To login to the Customer Portal, use your Username and Password from the registration
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email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:

Activation Key

ulw7jCODENGAEOFgbNzju TAToDWw/gLNmIX heuy+ki2Yi5V39cp3ginga)Z6mCh
MhlQfsILhFIgrEhQWxTEmuz L)i+1QycFEPkmX+Z5Y QP Xt7eSxgMUSHsUdPVskis
93Eel3mgHEa3w]HSQXuKKBzPlxDI8 lio5HSvmpp|LEEXvIaOkPRh4daraau3UK
rédrz GOxuk5jdOMfxzeyk(Q==

COPY TO CLIPBEOARD CLOSE

6. Copy the Activation Key with the Copy to Clipboard button.

See also:

e Activation on Windows

3.3.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver using ODBC Administrator, perform the following steps:
1. Run ODBC Administrator.

Data Sources

(ODBC)

2. In the System DSN tab click the Add button.
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'-:?. QODBC Data Source Administrator (84-bit) >

User DSM = System DSN  File DSN  Drivers Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver (e Add...
QDBC Driver for Azure_x32 32bit Devart ODBC Driver for SAL 5

QODBC Driver for BigCommerce_x32  32-bit Devart ODBC Driver for BigCor Remove
QDBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynarr

ODBC Driver for Firebird_x32 A2-bit Devart ODBC Driver for Firebirc Configure...

QODBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QODBC Driver for Mongo DB E4d-bit Devart ODBC Driver for Monge
QDBC Driver for MongoDB_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySGL 32bit 32-bit Devart ODBC Driver for MySQI ¥
< >

An QDBC System data source stores information about how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. In the appeared dialog box, select the installed driver, click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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4

General Advanced Settings License  About

License Information:

Trial period:
30 days left

Input Activation Key...

Test Connection - 0K Cancel

5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

Input Activation Key et

Activation Key:

U 1w FARODEBGAEOFghbMZUTAT oG faLMmIX heuy HdSpWCSHTE +d 2ZIUwmI +A4
ulw FCODANGAEOFgbNZjuTg Tl v /gLNmIX heuy +Hl 5 IN4ZZgxWh 2iMjxwr 15
97E 103mgHaa Sw 13 fS QKUK SzPIxDIS 1o 5 5vmppiL 3EXvIaOkPRh4arazuaUfi
a9BZh4ERVELA /PR IHWLZSX Z8k00 1 2Cx FaGy fv 1¥hiknLRE2LsbLMLPEmbxBC 2gn
WZSMMErH 729 50xMiFvZ IFNMsC 7 4sdOuigWQsRad s =

Load Key... Ok Cancel

6. If you have the activation key file, click the Load Key button and browse to it.

7. Click OK.
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3.3.3 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. In the Control Panel run ODBC Administrator

Data Sources

(ODBC)

2. Open the System DSN tab and click the Add button

; ODBC Data Source Administrator (64-bit)

User DSM = System DSN  File DSN  Drivers Tracing Connection Pooling  Sbout

System Data Sources:

Mame Platform  Driver & Add...
QDBC Driver for Azure_x32 32bit Devart ODBC Driver far SQL 5

QDBC Driver for BigCommerce_x32  32-hit Devart ODBC Driver for BigCor Remove
QDBC Driver for Cynamics_32 32bit Devart ODBC Driver for Cynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebirg Corfigure...

QDBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MalChimp_x32 32bit Devart ODBC Driver for MailCh
QDBC Driver for Mongo DB Gd-bit Devart ODBC Driver for Manga
QDBC Driver for MongoDB_x32 32bit Devart ODBC Driver for Manga

QDBC Driver for MeSGAL 32bit 32bit Devart ODBC Driver for MySQI ¥
< >

An ODBC System data source stores information about how to connect to the indicated data provider.
m; A System data sounce is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Select the driver and click Finish
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Create Mew Data Source

Select a driver for which you want to set up a data source.

43

Mame

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

£

1

4. In the appeared dialogue, select the License tab

Cancel
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General Advanced Settings License  About

License Information:

Trial period:
30 days left

Input Activation Key...

Test Connection - 0K Cancel

See also
e Product Activation

3.4 Connecting to Trello

This section describes how to connect to Trello using ODBC Driver for Trello

1. Driver Configuration

2. Obtaining a Refresh Token

3.41 Driver Configuration

Windows DSN Configuration

After installing the driver, create a DSN for ODBC Driver for Trello in the ODBC Data Source
Administrator.
1. Open the ODBC Data Source Administrator.
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e Type oDBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for Trello and click Finish. The driver setup dialog will open.

5. Enter the connection information in the appropriate fields. To proceed, click Sign in to Trello

to obtain a refresh token.

Devart ODBC Driver for Trello Configuration et

General Advanced Settings Tracng License  About

Data Source Mame  Trello

Description Devart QDEC Driver for Trello

Token I IS TI I SIS ST IR Y| ﬂSa'u'ETDkEI'I
Sign in to Trello ]

Proxy Server Port 0

Proxy User ID

Proxy Password [ 5ave Password

Test Connection o Ok Cancel

6. You may test the connectivity by clicking Test Connection.
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Devart QDBC Driver for Trello >

0 Connection successful

7. Click OK to save the DSN.

See Also

Connection String Parameters

Obtaining a Token

3.4.2 Obtaining Connection Details

To start the process of generating a token for the ODBC driver for Trello, follow the steps
below:

1. Run the ODBC Administrator utility and make proper settings in the driver's Configuration

dialog.

2. Click Sign in to Trello.
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Devart ODEC Driver for Trello Configuraticn

General Advanced Settings Tradng License About

Data Source Mame  Trello

Description

Token

Proxy Server
Proxy User ID

Proxy Password

Test Connection

Devart QDBC Driver for Trello

[ ] save Token

Sign in to Trello ]

[|save Password

3. In the window that opens, click Log in to proceed.

Port 0

47
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@7rellr

Would you like to give the following application
access to your account?

Devart ODBC Driver

> Devart ODBC Driver will be able to use your account until you
disable it.

Devart ODBC Driver is developed and maintained by Devart, and is
& not affiliated with Trello. By permitting access to your content you
assurne all related risks and liabilities.

Devart ODBLC Driver will be able to
e Read your name and username

= Make comments as you

s Read your email address

e Read your Enterprises

= Update and manage your Enterprises

» Read all of your boards and Workspaces

= Create and update cards, lists, boards and Workspaces
= Read Power-Ups you own

= Update Power-Ups vou own

Devart ODBC Driver will not be able to:
s See your Trello password

Trello's Privacy Folicy Deny

4. Specify your Trello credentials or select a different sign-in option to log in.
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M Trello

Log in to continue

Enter your email ‘

Or continue with:

G Google

=. Microsoft

@ Apple
=l

1 Slack

Can'tlogin? = Create an account

A ATLASSIAN

One account for Trello, Jira, Confluence and more.

5. Next, create your Trello account by clicking Create your account.

49
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M Trello

Create your account

Email address

b e gy | g— ==

Full name

- B oy

By creating an account, | accept the Atlassian Cloud Terms
of Service and acknowledge the Privacy Policy.

Create your account

Already have an Atlassian account? Log in

A ATLASSIAN

One account for Trellg, Jira, Confluence and more.

6. Now, click Allow.
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R7rellor

Would you like to give the following application
access to your account?

Devart ODBC Driver

dar
Lbsiamias
SwARch A, it
Dwart DDBC Diwer will be able 10 use your acoount until yeu
= disablia i
Duvvart DDBC Driwer & developed <

Fiy et 2fliated with Trdlo. 3

Dirsart DOBL Drivar will ba abde 1o

Drwart DDEC Drivar will it B obda 1o

o S wold Tralho pas s

Dirvart DDBL Drihvar will hirv access 1o thi folowing boards and

Trathor's Privacy Policy Deny m

If the process is successful, the token will be automatically generated and inserted in the
corresponding field of the driver configuration window.

7. Therefore, click OK to save your configuration settings.
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3.5

Devart ODEC Driver for Trello Configuration X

General Advanced Settings Tradng License About

Data Source Mame  Trello

Description Devart ODBC Driver for Trello

Token SRR RERERRERRRRRRRRRER ﬂSaVETDkEI'I

Sign in to Trello ]

Proxy Server Port 0

Proxy User ID

Proxy Password [|save Password

Test Connection . 0K Cancel

8. Finally, you can access your Trello account data.

See Also
Configuring ODBC Driver for Trello

Connection String Parameters

ODBC Driver for Trello Connection String Parameters

The following table lists the connection string parameters for ODBC Driver for Trello.

Parameter Description
Token The token that authorizes the driver to access your account data.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using ODBC Driver 53

Proxy Settings

Proxy Server
Proxy User ID
Proxy Password

Port

The proxy hostname or IP address.
The proxy username.

The proxy password.

The proxy port.

Advanced Settings

Allow NULL
Strings

Empty Strings as
NULL

ReturnForeignKeys

Connection

Timeout

Query Timeout

UTC Dates

To retrieve metadata, not all parameters, according to MSDN, can
accept a null value. If NULL, the driver should return an error. But
some 3rd-party tools pass NULL to the parameters. These options
should be enabled for compatibility with such tools.

Use the option to specify whether the driver must return foreign
keys. Retrieving metadata about foreign key constraints is a time-
consuming operation; many third-party tools request foreign key
metadata even whey they do not actually need this information.
Note that enabling the option may degrade performance of data
access operations. The default value is False.

The time (in seconds) to wait for a connection to open before
terminating an attempt. The default value is 60.

The time to wait for a query execution result before terminating and
generating an error.

Specifies whether all the datetime values retrieved from the data
source are returned as UTC values or converted to local time and
whether the date values specified on the application side (e.g., in
SQL statements) are considered UTC or local. The default value is

false.

Suppress Extended Select this option to reduce the number of API calls. Otherwise,
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additional extended API requests will be performed to query values
Requests
of lacking fields.

RegionalNumberSet Enables the use of local regional settings when converting numbers
tings to strings.
RegionalDateTimeS Enables the use of local regional settings when converting dates

ettings and times to strings.

Sets the behavior corresponding to the ODBC specification
version expected by a third-party tool. The behavior of the ODBC
driver can be changed by calling the SQLSetEnvAttr function to set
the SQL_ATTR_ODBC_VERSION environment attribute. Some third-
party tools expect the driver to exhibit ODBC 2.x behavior, but
forget to call sQLSetEnvAttr with the needed version, or pass the
incorrect value. In this case, the behavior can be explicitly set in the
Connection String.

® Default - The default value. The ODBC behavior is determined

ODBC Behavior

by a third-party tool.
* Ver 2.x - ODBC 2.x behavior is explicitly set.
* Ver 3.x-ODBC 3.xbehavioris explicitly set.

Sets the string value types returned by the driver as Default, ANSI,
or Unicode.

® Default - The driver defines the string types.

® Ansi - All string types are returned as SQL_CHAR, SQL_VARCHAR,
and SQL_LONGVARCHAR.
String Types .
® Unicode - All string types are returned as SQL_WCHAR,

SQL_WVARCHAR, and SQL_WLONGVARCHAR.

Set the parameter to Ansi or Unicode, if your third-party tool

supports only Ansi or Unicode strings.

Sample Trello ODBC Connection String

DRIVER={Devart ODBC Driver for ODBC Driver for
Trello};Token=mytoken
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3.6 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-Wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the

application, then click app1y.
. Click start Tracing Now.
. Restart all application processes.
. Click Test connection in the DSN settings to make sure the driver is able to connect.
. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© 0o N O O

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

56 ODBC Driver for Trello

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:
[oDBC(C]

Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

3.7 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Trello supports all deprecated functions for backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
Obtains an

environment,

SQLAllocHandle v" ISO 92 connection,
statement, or
descriptor handle.
Connects to a
specific driver by

SQLConnect v, ISO 92 data source name,
user ID, and

password.

Connects to a
SQLDriverConnect v ODBC
specific driver by
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SQLAllocEnv

SQLAllocConnect

Deprecated

Deprecated

connection string or
requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
environment handle
allocated from driver.
Obtains a

connection handle

ODBC API Calls for Obtaining Information about a Driver

and Data Source

Function Name Support

SQLDataSources

SQLDrivers

SQLGetInfo

SQLGetFunctions

v

Standard

ISO 92

ODBC

ISO 92

ISO 92

Purpose
Returns the list of

available data
sources, handled by
the Driver Manager
Returns the list of
installed drivers and
their attributes,
handles by Driver
Manager

Returns information
about a specific
driver and data

source.

Returns the functions
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SQLGetTypelnfo

ISO 92

supported by the
driver.

Returns information
about supported
data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes

Function Name

SQLSetConnectAttr

SQLGetConnectAttr
SQLSetConnectOpti

on

SQLGetConnectOpti

on

SQLSetEnvAttr

SQLGetEnvAttr

SQLSetStmtAttr

SQLGetStmtAttr

SQLSetStmtOption

Support

Standard
ISO 92

ISO 92

Deprecated

Deprecated

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

Purpose
Sets a connection

attribute.

Returns the value of
a connection
attribute.

Sets a connection
option

Returns the value of
a connection option
Sets an environment
attribute.

Returns the value of
an environment
attribute.

Sets a statement
attribute.

Returns the value of
a statement attribute.
Sets a statement

option
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. Returns the value of
SQLGetStmtOption v, Deprecated

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name  Support Standard Purpose
Allocates a
SQLAllocStmt v Deprecated
statement handle
Prepares an SQL
SQLPrepare v ISO 92 statement for later
execution.

Assigns storage for
SQLBindParameter v ODBC a parameterinan
SQL statement.

Returns the cursor

SQLGetCursorNam name associated
v, ISO 92 .
e with a statement
handle.
SQLSetCursorNam Specifies a cursor
v ISO 92
e name.
Sets options that
SQLSetScrollOption
v ODBC control cursor
S
behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose
Executes a prepared

SQLExecute v ISO 92
statement.
_ Executes a
SQLExecDirect v ISO 92
statement
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SQLNativeSql

SQLDescribeParam

SQLNumParams

SQLParamData

SQLPutData

ODBC

ODBC

ISO 92

ISO 92

ISO 92

Returns the text of an
SQL statement as
translated by the
driver.

Returns the
description for a
specific parameter
in a statement.
Returns the number
of parameters ina
statement.

Used in conjunction
with SQLPutData to
supply parameter
data at execution
time. (Useful for long
data values.)

Sends partor all of a
data value for a
parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information

about Results

Function Name

SQLRowCount

Standard

ISO 92

Purpose
Returns the number

of rows affected by
aninsert, update, or

delete request.
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Returns the number
SQLNumResultCols v, ISO 92 of columns in the

result set.

) Describes a column
SQLDescribeCol v ISO 92

in the result set.
Describes attributes
SQLColAttribute v, ISO 92 of a columnin the
result set.
Describes attributes
SQLColAttributes ' Deprecated of a columnin the
result set.

Returns multiple
SQLFetch ' ISO 92

result rows.

Returns scrollable
SQLFetchScroll v ISO 92

result rows.

Returns scrollable
SQLExtendedFetch v Deprecated

result rows.

Positions a cursor
within a fetched
block of data and
enables an
SQLSetPos v ODBC
application to refresh
data in the rowset or
to update or delete

data in the result set.

Performs bulk

insertions and bulk
SQLBulkOperations v ODBC

bookmark

operations, including
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update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic
Information

Function Name Support Standard Purpose
Returns additional

SQLError V' Deprecated error or status

information

Returns additional
diagnostic
information (a single
field of the

diagnostic data

SQLGetDiagField v ISO 92

structure).

Returns additional
diagnostic
information (multiple
fields of the

diagnostic data

SQLGetDiagRec v ISO 92

structure).

ODBC API Calls for Obtaining Information About
Database Objects (Catalog Functions)

Function Name Support Standard Purpose

Returns a list of
SQLColumnPrivileg columns and
v, ODBC _
es associated

privileges for one or
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more tables.
Returns the list of
SQLColumns ' X/Open column names in
specified tables.
Returns a list of
column names that
SQLForeignKeys v, ODBC make up foreign
keys, if they exist for
a specified table.
Returns the list of
SQLPrimaryKeys v ODBC column names that
make up the primary
key for a table.
Returns the list of
input and output

parameters, as well
SQLProcedureColu

mns

v ODBC as the columns that
constitute the result
set for the specified
procedures.
Returns the list of
procedure names

SQLProcedures v ODBC
stored in a specific

data source.

Returns information

about the optimal set
SQLSpecialColumn

S

v X/Open of columns that
uniquely identifies a

row in a specified
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table, or the columns
that are
automatically
updated when any
value in the row is
updated by a
transaction.
Returns statistics
about a single table
SQLStatistics v, ISO 92 and the list of
indexes associated
with the table.
Returns a list of
tables and the
SQLTablePrivileges v, ODBC privileges
associated with
each table.
Returns the list of
SQLTables y X/Open table names stored
in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

Commits or rolls
SQLTransact V' Deprecated

back a transaction

Commits or rolls
SQLEndTran v ISO 92

back a transaction.
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ODBC API Calls for Terminating a Statement

Function Name Support

SQLFreeStmt v
SQLCloseCursor v
SQLCancel v

Standard

ISO 92

ISO 92

ISO 92

Purpose
Ends statement

processing, discards
pending results, and,
optionally, frees all
resources
associated with the
statement handle.
Closes a cursor that
has been opened on
a statement handle.
Cancels an SQL

statement.

ODBC API Calls for Terminating a Connection

Function Name Support

SQLDisconnect v,
SQLFreeHandle v
SQLFreeConnect v,
SQLFreeEnv v,

Standard
ISO 92

ISO 92

Deprecated

Deprecated

Purpose
Closes the

connection.
Releases an
environment,
connection,
statement, or
descriptor handle.
Releases connection
handle.

Releases an

environment handle.
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4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Trello with ODBC-compliant tools.

e DBeaver

e Oracle Database Link

e Microsoft Access

e SQL Server Management Studio

¢ Microsoft Excel

e Microsoft Visual Studio

e OpenOffice and LibreOffice

* PHP
e Power Bl
* Python

e QlikView
* SSIS

e Tableau

41 Usingin DBeaver

DBeaver Overview

DBeaver is a free, open source multiplatform database management tool and SQL client for
developers and database administrators. DBeaver can be used to access any database or
cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,
Salesforce, or Mailchimp. DBeaver provides you with the most important features you'd need
when working with a database in a GUI tool, such as:

e SQL queries execution
¢ Metadata browsing and editing

e SQL scripts management
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e Data export/import

e Data backup

e DDL generation

e ER diagrams rendering

¢ Test data generation

e BLOB/CLOB support

e Database objects browsing

e Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports
NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,
SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though
that you can access a MongoDB database from DBeaver Community Edition using the
respective Devart ODBC driver. For the purposes of this guide, we'll use the Community
Edition of DBeaver to retrieve data from Trello via the Open Database Connectivity driver.

Creating an ODBC Data Source to Use Trello Data in
DBeaver

1. Click the Start menu and select Control Panel.

2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system
or select User DSN to configure DSN only for your account.

4. Click the Add button and double-click Devart ODBC Driver for Trello in the list.

5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for Trello with DBeaver, SQL_WVARCHAR data types may be
displayed incorrectly in DBeaver. To prevent this, you need to set the string data types to Ansi
either in the Advanced Settings tab of the driver configuration dialog or directly in the
connection string (String Types=Ansi) — all string types will be returned as SQL_CHAR,
SQL_VARCHAR and SQL_LONGVARCHAR.
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Devart ODBC Driver Configuration X
General Advanced settings  |icense About
Meta Data
- - - - -
Connection
-
L
Compatibility
ODBC Behavior Default hd
String Types Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LONE
Use Local Regional Settings when converting to string
[ ] Mumbers [ ]Dates and times
Test Connection e Cancel

Connecting to Trello Data from DBeaver via ODBC
Driver for Trello

Follow the steps below to establish a connection to Trello in DBeaver.

1. In the Database menu, select New Database Connection.
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Yy DBeaver 6.1.5

Eile Edit Mavigate Search SOL Editor | Database Window Help

¢ | 9 | 7 I3 i 4 + % NewDatabase Connection
L]

_ ) =% Driver Manager
f® Database Mavigator i3 | [F Projects

¥ Connect

Invalidate/Reconnect
Enter a part of table name here

QODEC - xBase_xbd

Change Connection(s) Driver
ODBC - ZohoCRM_x64

&, ODBC - MailChimp_x64 Pisconned

£ ODBC - MongoDB_x64 Disconnect All

= ODBC - Oracle x64 20 compare/Migrate >
= ODBC - salesforceMC_x64 3 Tools ,
= ODEC - SugarCRM_x64 Context tools Al

2. In the Connect to database wizard, select ODBC and click Next.

fw Connect to database O >

(1

Select your database
ODBC bridge driver

Type part of database/driver name to filter & Gallery

Mame # ~
= ODBC 7
& Apache Ignite
5 AwWS
A Azure

3. Enter the previously configured DSN in the Database/Schema field.
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fy Connect to database O *

Generic JDBC Connection Settings
, _ =O0DBC
ODBC connection settings

General Driver properties S5H Proxy

JDBC URL: ‘ jdbciodboDBEAVER_DATASOURCE

Database/Schema: | DBEAVER_DATASOURCE |

User name: ‘ |

Passward: ‘ | Save password locally

4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing Trello Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all

the tables in Trello database. To view and edit the data in a table, you need to right-click on
the target table name and select View data.The content of the table will be displayed in the

main workspace.
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ryt DBeaver £.1.5 - Employees
File Edit Mavigate Search SCLEditer Database Window Help

e-lv N |TD0 T o] amw |-«
f= Databas.. &3 = OB A Compensatory... FB CumentlyRun... A Departments
¢ - | = ¥ FE Properties | I} Data ,5,%‘,-3 ER Diagram
Enter a part of table name here
A
EF Disciplinaries ~ |EBEmployees [, §
R EEC + 5 + o
) = Id T FirstNarme T71 LastMame T1
EE EmployeeSalaries =
FF Employees iz 1 Tia Burmen
EB FMLA 2 3444700000014104%  Ruby Richards
E® Forms £ 3 34447000000141048  Morgan Finely
BB Irca '[: 4 344470000001 41047 Jennifer Jackson
BB Jobs * 5 | 34447000000141046 George Dwell
FE Leaves 6 34447000000141045  Dave Duken
ER OsSHA 7 34447000000141044  Charles Mavric
EE Projects ] 34447000000141043  Austin Mayer
BB Separations 9 | 34447000000141042 Aleo Kirb
D Tasks 10 | 34447000000141041  Allan Francis
R Timelogs 11 | 34447000000139001 ks
FE TimeTrackerSettings TR

If you want to write a custom SQL query that will include only the necessary columns from the
table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.
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fy DBeaver£.1.5 - <0ODBC - Zoho People> Script-3

File Edit Mavigate Search S50LEditor Database Window Help

PR S T vi@] At |~ & ODBC-ZohoPeople

{® Database.. I Projects = B | [T *<0ODBC - Zoho People> Script-5 53

“_ - | PE 9 SELECT "Id", "FirstName", “LastName" FROM Employees;

Enter a part of table name here b
EH Disciplinaries ”~
FR EEO B Employees 52
g EmployeeSalaries T SELECT "Id”, "FirstName", "LastName" FROM Er |52

Employees
BB FMLA = Id T FirstMarme T ] LastMame T T
FA Forms % 1 | Tia Burmen
B lrca 2 | 34447000000141049 Ruby Richards
£B Jobs o 3| 34447000000141048 Morgan Finely
g 'E]ESE:;S T 4 | 34447000000141047 Jennifer Jackson
= Project B 34447000000141046 George Dhwell
= S'DJE :, 6 | 34447000000141045 Dave Duken
eparations —
= Tafks 7 344470000007471044 Charles Mavric
8 34447000000141043 Austin Mayer
EB Timelogs ¥
EF TimeTrackerSettings 9_ 344470000007141042 Aleo Kirb
7 Timesheets 10| 34447000000141041 Allan Francis
R TrainingFeedbacks 11| 34447000000135007 ks
4.2 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a

standalone.

Configure the Initialization File

After installing the gateway and the ODBC driver for Trello, create an initialization file for your
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Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initTrello.ora. You need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_FDps_conNecT_1INFo parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=Trello

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orAcLE_HoME \NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = Tocalhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_naAME) must be the same in listener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=
(SID_NAME=Trel10)

(ORACLE_HOME=D: \ORACLE_HOME)
(PROGRAM=dg4odbc)

)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The sip must match the value specified in the

listener.ora file.

Trello =
(DESCRIPTION =
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(ADDRESS = (PROTOCOL = tcp) (HOST = localhost) (PORT = 1521))
(CONNECT_DATA =
(SID = Trello)

)
(HS = 0K)
)
Create Database Links
To access an ODBC data source, you must create a database link using a database tool like
SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the
CREATE DATABASE LINK statement, as follows:
CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also
Configuring Oracle Database Gateway for ODBC

4.3 Using in DBxtra

Troubleshooting Trello ODBC Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to Trello in DBxtra.

Due to incompatibilities between DBxtra and Trello, leaving the sqQL dialect property to its
default might present various issues. To resolve compatibility issues, set the property to ms
Access 2000/XP/2003 Or ANSI sQL/2003 for DBxtra version 11.0.1 or newer, and to AnsI
sqL/2ee3 for versions prior to 11.0.1.
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Connect through ODBC E3

NOTE:

Imiportant!

Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.

Please be sure to select the right SQL dialect for your connection.

Connection name |MyData

Data source |DataSource 1 III

User

Password

Connection timeout 15 : S0L dialect || M5 Access 20000 |w

Enable Offline Mode

Get columns descriptions
Select User Groups who can view this Connection

[#]accounting n
[]contraling

Guest Group

[~ILegal

Management

[#IManufacturing

[#Marketing

[Purchasing W

Select Al Unselect Al Cancel

4.4 Using in Microsoft Access

Connecting Microsoft Access to Trello Using an ODBC
Driver

This article explains how to connect Microsoft Access to Trello through the standard ODBC
interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
spreadsheet applications like Excel to organize, store, and retrieve large amounts of related
data that can be difficult to manage in spreadsheets.
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In Microsoft Access, you can connect to your Trello data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. It is
assumed that you have already installed and configured a DSN for ODBC driver for Trello.
For the purpose of this article, we tested an ODBC connection to Trello through our ODBC

drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft
Access 2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe
how to use Microsoft Access 2019 to import or link to your data in Trello.

Importing Trello Data Into Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Trello and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps
checkbox. Click Close.

9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Trello Data in Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
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ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Trello and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click
OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Trello table as the unique record identifier. You are linking
multiple tables, you will be prompted to select unique record identifiers for each of the
selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

4.5 Using in Microsoft Excel

Connecting to Trello from Microsoft Excel using ODBC
Driver for Trello

You can use Microsoft Excel to access data from a Trello database using ODBC connector.
With ODBC Driver, you can import the data directly into an Excel Spreadsheet and present it

as a table. Make sure that you use matching Excel and ODBC Driver, e.g. if you have
installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to Trello with Get & Transform (Power Query)

e Connecting Excel to Trello with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to Trello with the Query Wizard

e Connecting Excel to Trello with Microsoft Query
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e Connecting Excel to Trello with PowerPivot

Connecting Excel to Trello with Get & Transform (Power
Query)

You can use Get & Transform (Power Query) to connect to Trello from Excel with ODBC.
This method assumes that you've installed an ODBC driver for Trello.
1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other

Sources > From ODBC.

=] Bookl - Excel Evgeniy Lemeshov |
Fila Home Insert Page layout Formulas Review View Help Q Tellme S Share
O [ |_ B a [TA ~N [E fe g
SFEIEELED A R EEE
=1 i ) .
Get Refresh z| Sort Filter Text to What-If Forecast Outline
D A h £ =L @| .
Data - All - ¥  Columns =2 Analysis = Sheet M
Gi Sort & Filter Data Tools Forecast ~
ﬁ From File *
E b a
From Database » - - - - =
— 1 3
F m - 1 + 100%
= am From Azure * From Table/Range
-]

B
_E) From Online Services 4 _@ From Web

B
¢. From Other Sources L From Microsoft Query

e
Fj Combine Queries » _¢. From ODBC

e

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the
connection string for your data source (without credentials, which are defined in the
credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.
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From ODBC

Data source name (DSN)

Devart ODBC Dniver b

4 Advanced options

Connection string (non-credential properties) (optional) &

501 statement [optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (opticnal)

(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.

ODBC driver
Default or Custom @ dsn=Devart ODBC Driver
. Use a username and password to access a data source with an QDBC driver,

Windows

User name
Database myusemame

Password

FEERRBERDEE

Credential connection string properties (optional) (O

Back Cancel
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If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom '¢' dS'_' =Devart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (D)

Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.

o X
Navigator
R Employees B
Select multiple items Id FirstName LastMame Addre:
Display Options ~ [% 34447000000132001 ks nufl
34447000000141041 Allan Francis
4 F5 ODBC [34]
~ 34447000000141042 Aleo Kirty
A ADA 34447000000141043 Austin Mayer
A Announcements 34447000000141044 Charles Mavric
Bl Assets 34447000000141045 Dave Duken
[ Attendances 34447000000141046 George Dwvell
B Benefits 34447000000141047 lennifer Jackson W
LW 34447000000141048 Morgan Finely
B Clients r'd >
Select Related Tables load |~ Transform Data Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.
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File Home Insert Draw Page Layout Formulas Data  Review View Add-ins | Help Team  Table Design >
Table Mame: Summarizewith PivotTable F‘ @ |:|51 =23
: =y = L& 4
E‘mplnyees ﬁRemnve Duplicates Insert B L ?‘ Table Style Quick
‘B Resize Table | G Convert to Range Slicer v ~ S35 | Options> | Styles~
Properties Tools External Table Data Table Styles ~
L12 " 5 Information Technology v
A B C D E E G H | -
1| Icﬂ FirstName ﬂ LastName ﬂm:ldressﬂ Emailld ﬂ Photu JobDescription HSource{)inreﬂ Geru:lerﬂ App
2 |3444ks https://contacts.zoho.eu/file?ID=20063641615&fs=thun App
3 |3444 Allan Francis https://people.zoho.eu/ne Direct Male App
4 3444 Aleo Kirb https://people.zoho.eu/ne Direct Female  App
5 |3444 Austin Mayer https://people.zoho.eu/ne Referral Male App
& |3444 Charles Mavric https://people.zoho.eu/ne Direct Male App
7 |3444 Dave Duken https://people.zoho.eu/ne Referral Male App
8 |3444 George Dwell https://people.zoho.eu/ne Direct Male App
o | i

r larkenn hittnc (M fnannla 2nhn andne Diract Eomalo fmnl |7
Employees | Sheetl | ()] 4 3

Connecting Excel to Trello with Data Connection Wizard
(Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has
already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.
2. In the opened dialog, select ODBC DSN and click Next to continue.
3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Trello with the Query Wizard

You can use this option to create a simple query for retrieving data from Trello to Excel via
ODBC driver.
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1. Open Excel, in the main menu, click the Data tab.
. Click the From Other Sources dropdown menu, and then click From Microsoft Query.

. In the appeared dialog, you can choose the data source you want to connect to.

A WN

. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.
. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.

. Select Return Data To Microsoft Excel and click Finish.

0 N O O

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.

Connecting Excel to Trello with Microsoft Query

You can use this option to create a more complex query for retrieving Trello data to Excel via
ODBC driver.

1. Start Excel, click the Data tab.
2. In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

3. In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Trello). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

4. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

5. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Trello with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data
models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.
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3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC Trello), and then click Next.

6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).

7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

4.6 Using in Microsoft Visual Studio

Importing Trello Data into Visual Studio Through an
ODBC Connection

A Visual Studio is a powerful tool containing features that allow editing, debugging, and
compilating the code and creating applications that can be connected to any databases
product and services on a local machine and network, and any type of cloud (private, public,
or hybrid). To connect Visual Studio to a data source such as Trello, you can use an
appropriate ODBC driver.

This guide describes how to connect to Trello and retrieve data importing them to Visual
Studio with an ODBC driver. It is assumed that you have already installed and configured a
DSN for ODBC driver for Trello.

1. Run Visual Studio Desktop and click Tool and select Connect to Database.

2. In the Add connection dialog box, select the Microsoft ODBC Data Source as a data
source.

3. In the Data source specification point expand the Data Source Name (DSN) drop-down
list and select the previously configured DSN for Trello. Alternatively, you can connect to
the database by entering the DSN in a Use connection string field. To check whether
your connection is successful, click Test connection. Click OK.

4. If your data source is password-protected, Visual Studio will prompt you for user

credentials. Type your Username and Password in the respective fields and click OK.

5. In the Server Explorer you can see the database structure. Choose Tables, right-click the
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4.7

4.71

table you want to view the data of and select Retrieve Data. You can also preview the

contents of the database objects by clicking on them.

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Trello from SQL
Server Management Studio using ODBC Driver for Trello.

¢ Creating a Linked Server

e Troubleshooting in SSMS

Creating a Linked Server

Requirements

In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

¢ The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysWOW64\odbcad32.exe.

e ODBC Diriver for Trello and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to Trello from SQL Server Management
Studio using ODBC Diriver for Trello

You can use the Microsoft SQL Server Management Studio to connect your Trello data to an
SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as Trello and
merge them with your SQL Server database. You can create a linked server with one of these
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methods: by using the options in the Object Explorer or by executing stored procedures.
Below are major advantages of using SQL Server Linked Servers to connect to Trello:
1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the
organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Trello

You can follow the steps to create a linked server for Trello in SQL Server Management
Studio by using Object Explorer:
1. Start your Management Studio and choose your SQL Server instance.

2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers
and then click on New Linked Server.
3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.
e Under Server type, select Other data source .
e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.
¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for
Trello . Alternatively, you can input the ODBC Driver connection string in the Provider

field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access Trello databases through SQL Server.

Retrieving Data From Trello

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Object Explorer

Connect~ ¥ *¥ (R

= @ ALINAK\SQLEXPRESS (SOL Server 15.0.2080 - DATA
Databases
Security
= Server Objects
Backup Devices
= Linked Servers
= Providers
@t ADsDSOObject
@t Microsoft ACE.OLEDB.12.0
@t Microsoft ACE.OLEDE.16.0
@t MSDAQSP
wE MSDASCOL
wE MSOLAP
Wt MSOLEDBSCL

In the appeared Provider Options window, enable the Allow inprocess checkbox:

®H Provider Options - Microsoft OLE DB Provider for ODBC Drivers -

Selecta page IT Script ~ &) Help
& General

Provider options:

Enable Name
Dynamic parameter
MNested queries
Level zero only
Allow inprocess
Maon transacted updates
Index as access path
Digallow adhoc access

Supports "Like’ operator

Limlemd mmmamen samimn thin meossid e

Create a new Linked Server
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Object Explorer * I X
Connect~ ¥ ¥ VIS
= @ EVGEMIYL\SQLEXPRESS (SCL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...
Triggers Start PowerShell
Replication
PolyBase Reports ’
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
Selecta page HSGI‘iDt"ﬂHeIp
# General
& Security
& Server Options b
Server type:
() 5QL Server

(®) Other data source

Pravider: Microsaft OLE DB Provider far ODBC Drivers w

Product name:

Data source:

Location

| |
| |
Provider string: | |
| |
| |

Catalog

Connechon

Now you need to input the Linked Server name, e.g. TRELLO. In the Product Name and Data
Source fields you need to indicate the System DSN that you've previously created - more info
on System DSN setup can be found here.
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*3 Mew Linked Server — O
Select a page ﬂScnpt v € Help
JF General
F Security
J& Server Options Linked server: GOOGLESHEETS
Server type:

() 0L Server

D Other data source

Pravider: Microsoft OLE DB Provider for ODBC Drivers
Product name: ODBC Driver for Google Sheets
Data source: Google Sheets

Provider string:
Location

Catalog
Connection

The Trello tables are already available to be fetched. To query the linked server, click New
Query in the toolbar:

File Edit View Project 50L Complete Tools Windoy

i0-0|8®-1-2 | B New Query B & &
':: | | b Execute
I
Object Explorer v B X
Connect~ ¥ ™ G W

= E EVGEMIYL\SOLEXPRESS (5QL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
.
Providers
B ORACLE
B POsSTGRESGOL
B sauTe

BEEHEBE

Enter your SQL query in the editor window and click Execute to run the query:

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools 89

|.$; SC0LCueryl.sql - ALINAKNSOLEXPRESS.master (DATASOFT\alinak (73))* - Microsoft S0L Server Management Studio
File Edit View Query Project Tools Window Help

°' |ilﬁ' "’Hﬂ"'lfé'lNEWQUEW @nn:nn::ﬂn§a|%|j—‘l |.9' '|@| '|P
L | master < | b Eecute w v 3 B[] 28| BFED| | B
Object Explorer Ll SOLQueryl.sgl - AL..TASOFT\alinak (73))* &= X _
Comnect~ § ¥ G select * from [ZOHOPEOPLE]. .. [Employess]
= @ ALINAKSOLEXPRESS (SQL Server 15.0.2080 - DATASOFTW.
Databases 100 % -
Security FH Resuts gl Messages

= Server Objects

Backup Devices Id FirstName LastMame Address Emailld Photo
g Linked Servers 1 34447000000141050  Tia Burmen MULL MNULL  hitps://p...
= Praviders 2 34447000000141049  Ruby Richards ~ NULL NULL  https//p...
S8 ADsDSO0bject 3 34447000000141048  Morgan Finely MULL NULL  hitps://p...
&H Microsoft.ACE.OLEDB.12.0 4 34447000000141047  Jennifer Jackson MULL NULL  hitps://p...
aﬂ Microsoft ACE.OLEDE. 16.0 5 34447000000741046  George Dwell MULL MULL  hitps://p...
ﬁﬂ MSDADSP E 34447000000141045  Dave Duken MULL MULL  hitps://p...
@ MSDASOL 7 34447000000141044  Charles Mavric NULL NULL  hitps:/fp...
@8 MSOLAP a 34447000000741043  Austin Mayer MNULL NULL  https//p...
@8 MSOLEDBSQL 9 34447000000141042  Mleo Kirbs MULL NULL  https://p...
@l Search.CollatorDS0 10 34447000000141041  Allan Francis MNULL NULL  hitps://p...
w8 SOLNCLITI 11 34447000000139001 ks MULL NULL  NULL  httpsific...

As a result, you can see the contents of the selected table retrieved directly from the Trello
account you are connected to.

See also
¢ Troubleshooting SSMS

4.7.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:
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-
. Compenent Services

Console Root
a 0 Component Services
4[] Computers
a & My Computer
» [o] COM+ Applicatio
[ -] DCOM Config
& [2] Running Processe
[ fj] Distributed Trans:
[ E Event Viewer (Local)
3 Q.,, Services (Local)

Windo.., Windows... Windows R.. Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo.,..  Windows.. WMIPro.. WMIProvi.

s & & &

Micresoft.... Microsoft.L... MicrosoftV... Microsoft....

ApplD
MMC (ALY MSMDPP - MsRdpSess...
Applicati.. LIZE

¥ & & &

MSTTS MahimicSe... MAP Agent Map Elevated
DecObj Cla.. Service COM class
NCLUA NDFAPI netman netprofm

¥ & & @&

NetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions »

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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F B
MSDAINITIALIZE Properties L2 ||

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions
available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are
connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D 1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

< - s i = iy et o -

Change ownerta:

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

.
| Permissions for (2206CDB0-10C1-11D1-89E0-00COAF... ()

Securty

Group or user Names:

52 NETWORK SERVICE

52, Users |
82 Trustedinstaller

“Users)

A pdministrators (20 e

1| 1]

93

Add.. ] [ Bemove ]
Pemissions for Administrators Allow Dery
Full Cortral ]
Read O

Special permissions

For special permissions or advanced settings,
click Advanced.

Leam about access contral and permissions

ok ] [Cance 7] [ oy

After this you should be able to edit MSDAINITIALIZE security settings .

See also

e Error message when you try to create an instance of an OLE DB provider in SQL Server:

"Cannot create an instance of OLE DB provider"

4.8 Using in OpenOffice and LibreOffice

Connecting to Trello from OpenOffice and LibreOffice
using ODBC Driver for Trello

The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Trello data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
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of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
Trello, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

€5 OpenOffice”4

‘E Text Document; Drawing
Spreadsheet EE] Database
Presentation E Formula

@ Open... = |_D_| Templates..

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name

of your data source into the field, e.g. ODBC Driver for Trello, or you can click Browse,

double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Trello and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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Mew Database.cdb - OpenOffice Base — O %

Eile Edit ¥iew |nsert Tools Window Help

‘B R E-e ., B

e

ﬁ Ei: Create Table in Design View... Description
1@ [ﬁ Use Wizard to Create Table...
Tables
F
ER
Cueries
e
Forms

CompanyPolicies ~ MNone =
CompensatoryOffs

CurrentlyRunningTimer

Reports Departments

Designations v

9 Employees - Mew Databasel3 - OpenOffice Base: Table Data View
File Edit View Inset JTools Window Help

B & i F- 7 W R v

||
Id |FirstName| LastMame |Address| Emailld| Photo | 50urceG’FHire| Gender| ApprovalStatus

34447\ Tia Burmen https://pe Referral Fermale Approval Mot Enabled
34447 Ruby Richards https://pe Web Fermale Approval Mot Enabled
34447 Morgan | Finely https://pe Web Male Approval Mot Enabled
 |34447 Jennifer  Jacksen https://pe Direct Female Approval Mot Enabled
34447 George Dwell https://pe Direct Male Approval Mot Enabled
 |34447 Dave Duken https://pe Referral Male Approval Mot Enabled
 |34447 Charles Mavric https://pe Direct Male Approval Mot Enabled
 |34447 Austin Mayer https://pe Referral Male Approval Mot Enabled
 |34447 Aleo Kirk https://pe Direct Fermale Approval Mot Enabled
34447 Allan Francis https://pe Direct Male  Approval Mot Enabled
34447 ks https://co Approval Mot Enabled

7. To create an SQL query, click Queries in the Database pane, then click Create Query in
SQL View...

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools| 103

MNew Database.odb - OpenOffice Base -
File Edit Wiew

B - -

[ Create Query in Design View...
lﬂ Use Wizard to Create Query...
|§Eu. Create Query in 5QL View... |

Insert Tools Window Help

F—éf'ené ' L

Description
Create a query entering an SOL statement dire

ﬁ

Tables

e

Queries

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

5 Mew Database.odb : Query - OpenOffice Base: Query Design
File Edit View Insert Tools Window Help

|l || R i - sl i
=) % IR RIS RaE
Id |FirstName| LastName|Address| Emai||d| Photo | SourceCl’FHire| Gender| ApprovalStatus

b [EREal Tia Burmen https://pe Referral Female |Approval Mot Enabled
34447 Ruby Richards https://pe Web Female |Approval Mot Enabled
34447 Morgan | Finely https://pe Web Male  Approval Mot Enabled
 |34447 Jennifer  Jackson https://pe Direct Female |Approval Mot Enabled
34447 George | Dwell https://pe Direct Male  Approval Mot Enabled
 |34447 Dave Duken https://pe Referral Male  Approval Mot Enabled
 |34447 Charles  Mavric https://pe Direct Male  Approval Mot Enabled
 |34447 Austin Mayer https://pe Referral Male  Approval Mot Enabled
 |34447 Aleo Kirb https://pe Direct Female Approval Mot Enabled
34447 Allan Francis https://pe Direct Male  Approval Mot Enabled
Record |1 of 1N S0 (][ 2] 4

SELECT * FROM Emplovees
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49 Using in PHP

Connecting to Trello from PHP using ODBC Driver for
Trello

PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Trello via ODBC. The script connects to Trello

database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for Trello};R
Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($ODBCConnection, $SQLQuery);

Step 3: Print the result set
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The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

$result = odbc_result_all($Recordset, "border=1");
odbc_close($0DBCConnection);

7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.

Using in Power Bl

Importing Trello Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Trello, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to Trello and import data into Power Bl Desktop using an

ODBC driver. It is assumed that you have already installed and configured a DSN for ODBC

driver for Trello.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Trello

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user

credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
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of the database objects by clicking on them.

7. To load the Trello data into Power Bl for analysis, select the needed table and click Load.

411 Using in Python

Installing the ODBC Driver for Trello

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for Trello. To use the ODBC driver as a

translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting to Trello from Python using ODBC Driver for
Trello

Here’s an example to show you how to connect to Trello via Devart ODBC Driver in Python.

First we import the pyodbc module, then create a connection to the database, insert a new
row and read the contents of the EMP table while printing each row to the Python interactive
console. To execute the script, you can type the code directly in the interactive console or add
the code to a file with the .py extension and run the file from the command prompt.

Step 1: Connect

import pyodbc _
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Trello};Refresh Token=

Step 2: Insert a row
Here's a simple example of how to execute an insert statement to test the connection to the

database. The script inserts a new record to the EMP table.

cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott

Step 3: Execute query
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The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.
cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:
print (row)
row = cursor.fetchone()

cursor.close()
cnxn.close()

Using in QlikView

Connecting to Trello from QlikView using ODBC Driver
for Trello

This tutorial describes how to connect and configure QlikView to retrieve data from Trello for
further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data

sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or

later.

To connect to an ODBC data source from QlikView using our driver for Trello, perform the
steps below:
1. Open the QlikView client application and click File > New. Close the Getting Started

wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{| File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help
{0 New Ctri+N || & | #a| v | [ | @) |5? B ¢ K Clear ~| @ Back &) Forward | & Lock &' Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites »
= save Ctrl+5
Save As... F12
Mail as Attachment...
Mail with Bookmark as a Link
| P . +P
Print Sheet...
Source Control »
Export »
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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V]
File Edit Insert Tab Tools Help
-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main v |23 =

[GET

@ Connect to Data Source s

User ID Pazswond

|m_l,.lid | | sesee| |

Canecel

Data Sources

Help

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
- - - Devart ODBLC Driver for bMagento
Dats  Functions Variables  Settings Dievart ODBC Ciriver for MaiChimp
. Diewart ODBC Diriver for MySEIL
Database Diata from Files | | Devart ODBC Driver far MetSuite
. Dewart ODBC Driver for Oracle

| el ~ Connect... L] Relative Faths Dievart ODBC Diriver for SOL Azure
[JUseFTP Dievart ODBC Driver for SGLite
[ Fores 32 Eit Select... Meseart ONAC Mriver bor o sce

[ Show User DSMs

Test Connection...

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.
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&= Edit Script [OV4] — O >
! File Edit Inset Tab Tools Help
_L Reload ¥ Debug | = | © A | O [ k51 [ 5 Tabs, Main > |ad =

b ain

CDEC CONNECT TCO [Zcho People];
SELECT * FROM Employees;

Data  Function: Variables Settings

Databaze Drata from Files
| ODBC “ sttt [ Relative Paths Table Files..
[ Farce 32 Bit Seloct. . [JUse FTR Qlikiew File...
"Web Files. .
Field Data. .

Cancel Help
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Sheet Properties [Main]

General Fields  Objects

Awvailable Fields

Securty Triggers

AboutMe
AddedBy
AddedByld
AddedTime
Address

Age

Approval Status
AskMeAbout_Expertise
BirthDate
CreatedDate
DateCf Exit
DateCfJoining
Department
Department|d
Dependert
Designationid
Education
Emailld

Fmnlovesld

Add =

Add All ==

< Remove

Fields Displayed in Listboxes
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4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.
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# Create Select Statement — | =
Data source Zoho People Connect.
Database Diriver. ..

Owaner Suppart.

[Databasze Tables

[]5haow all EEQ

T ablez =

Views Emplopees alaries
FriLa,

[ 5ymonyms Farms

Sustem Tables lica

[ aliases A

Fields | Text Order v|

AboutMe
AddedBy
AddedByld
AddedTime

A1

[] 5how leon for Key Fields

Script Table Columns  Preview  Blobs

SQL SELECT * (®) Colurnin
FROM Employees; ) Row
() Stuctured
] Preceding Load
Add

5. Once the data has been fetched, you can choose a table layout to present the data in a

table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to

the tablebox and click OK.
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& QlikView x84 Personal Edition - [C\Users\ ALINAKNDownloadsh 11.guw™]

File Edit VWiew Selections | Layout | Settings Bookmarks Reports  Tools  Object Window  Help
B | S| S S| ] Add Sheet.. @?EEI}C}CIEErﬁ@Back 23) Forward |
Main i
Id P g
3444 7000000132001 ~ e = SEs
3444 7000000141041 s Select Fields...
344470000001 41042 - - =
34447000000141043 ||| New Sheet Object v (B List Box..
344470000001 41044 %4 Rearrange Sheet Objects Z|| Statistics Box...
344470000001 41045 1 1 )
34447000000141046 o 84 Adjust Off-Screen Objects =l Multi Box...
34447000000141047 : Align/Distribute » [[E Table Box..
344470000001 41045 et pi =
3444 7000000141049 sufnewtte = Jdlff Chart...
3444?000000141050 BU,III'IEW|':I:|2]_ 11:78:04 =_| |r|F||_|t Box...
Tia uinewhzy 11:28:33 V| Current Selections Box...
TILLPS ) PSUIG 20 |u.6LI,|II'IEW|':I:|2]_ 11:28:33 E
https:/people. zoho,eufnewkoz1 11:28:33 D Button...
https:/{people.zoho. eufnewb oz 11:28:33 Al Text Object...
https: ffpeople.zoho.eufnewboz1 11:28:53 =
021 11:28:33 _=:| Line-'Arrl:uw Ob_iECt...
09.11.2021 11:28:33 & Slider/Calendar Object...
09.11.2021 11:28:33 ) .
09.11.2021 11:28:33 irl Bookmark Object..
09.11.2021 11:28:33 C{l Search Object...
@ QlikView x64 Personal Edition - [C:h\Users\ ALINAK\Downloadsh 117, quw®] — | *
! File Edit View Selections Layout Settings Bookmarks Reports Tools  Object  Window Help -8 X
PGl OO |l ve) 4] @) k? B K Clear - | (O Back ) Forward | @ lock &
Main
Bfla @ o~
Id First... LastMame Gender Photo SourceOfHire PhotoDownloadUrl
34447000000141050  Tia Burrien Female https:f/people, zoho,eu/new... Referral htkps://people, zoho, ey
34447000000141049  Ruby Richards Female https:jfpeople. zoho.eufnew... web https:/fpeople.zoho. el
34447000000141048  Morgan Finehy Male https:/fpeople, zoho,eufnew... Web https:/fpeople.zoho. e,
34447000000139001 ks - - htkps:flcontacts, zaho, eoffl... - htkps:ficontacts, zaho,
34447000000141047  Jennifer Jackson Female https:jfpeople. zoho.eufnew... Direct https:/fpeople.zoho. el
34447000000141046  George Dol Male https:jfpeople, zoho,eufnew.,, Direct https:/fpeople.zoho. e,
34447000000141045  Dave Duken Male htkps:f/people, zoho,eu/new... Referral htkps://people, zoho, ey
3444700000014104¢  Charles Iantic Male https:jfpeople. zoho.eufnew...  Direct https:/fpeople.zoho. el
34447000000141043  Auskin IMawer Male https:jfpeople. zoho.eufnew... Referral https:/fpeople.zobo. e
34447000000141041  Allan Francis Male htkps:f/people, zoho,eu/new.., Direct htkps://people, zoho, ey
34447000000141042  Alen Kirb Female https:jfpeople. zoho.eufnew... Direct https:/fpeople.zoho. el
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Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for Trello as a
translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the

Advanced Settings tab and select ver 2.x from the obec Behavior dropdown.

General Advanced setfings License About

Meta Data
Connection
-
-
Compatibility
QDBC Behavior Ver 2, e
String Types Default b

|Use Local Regional Settings when converting to string

[]mumbers [ ]Dates and times

Test Connection - Cancel
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414 Usingin Tableau

Importing Trello Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to Trello from Tableau Desktop.

Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,

and create meaningful reports to get actionable insights. With Tableau Desktop and our suite

of ODBC drivers, you can connect to various relational and non-relational databases, both

cloud and on-premise.

1.
2.
3.

© 0 N O O

Run Tableau Desktop.
On the start page, select More... in the Connect pane.

Choose Other Databases (ODBC).

. Expand the DSN drop-down list and select the DSN that you have created and configured

for Trello. Alternatively, if you have not created a DSN, you can choose the Driver option

and select Devart ODBC Driver for Trello from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Trello.

. You should see the list of all tables you have access to in the connected data source.

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the

data, or click New Custom SQL to write a query that will select only specific data from the

table.

10.Hit Update Now to retrieve and display the data.
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